
The science behind the report:

Empower your business 
collaborators with a fast Intel Core 
processor‑powered Chromebook

This document describes what we tested, how we tested, and what we found. To learn how these facts 
translate into real-world benefits, read the report Empower your business collaborators with a fast Intel Core 
processor‑powered Chromebook.

We concluded our hands-on testing on November 4, 2020. During testing, we determined the appropriate 
hardware and software configurations and applied updates as they became available. The results in this report 
reflect configurations that we finalized on October 26, 2020 or earlier. Unavoidably, these configurations may not 
represent the latest versions available when this report appears.

Our results
Table 1: Time in seconds to complete tasks in various apps.

Configuration A Configuration B Configuration C Configuration D Percentage win

Task

Acer Chromebook 
CB-315-3H with 
Intel Celeron 
N4020

Acer Chromebook 
Spin CP713-2W-
38P1 with Intel 
Core i3-10110U

Acer Chromebook 
Spin CP713-
2W-5874 with Intel 
Core i5-10210U

Acer Chromebook 
Spin CP713-2W-
79H3 with Intel 
Core i7-10510U

Configuration D  
vs.  

Configuration A

Scenario 1

Median sum of all tasks for 
Scenario 1 79.8 57.2 55.0 50.7 36%

Google Meet

Launch Google Meet 2.0 1.5 1.6 1.3 35%

Launch new meeting 2.7 2.1 1.8 2.0 25%

Google Drive

Open PDF preview from 
Google Drive 7.3 7.1 6.6 5.7 21%

Print Preview PDF 35.9 25.4 27.2 25.2 29%

Google Docs

Open shared .docx file in 
Google Docs 14.07 8.74 7.18 6.97 50%

Convert .docx file to Google 
Docs document 14.97 9.91 7.90 6.70 55%

Downloaded converted doc 
to .docx 3.01 2.55 2.84 2.93 3%
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Configuration A Configuration B Configuration C Configuration D Percentage win

Task

Acer Chromebook 
CB-315-3H with 
Intel Celeron 
N4020

Acer Chromebook 
Spin CP713-2W-
38P1 with Intel 
Core i3-10110U

Acer Chromebook 
Spin CP713-
2W-5874 with Intel 
Core i5-10210U

Acer Chromebook 
Spin CP713-2W-
79H3 with Intel 
Core i7-10510U

Configuration D  
vs.  

Configuration A

Scenario 2

Median sum of all tasks for 
Scenario 2 1,388.4 655.0 530.0 470.7 66%

Unarchiving photos

Transfer 140 photo .zip 
archive from USB 59.2 28.6 28.1 28.4 52%

Unzip 140 photos to desktop 127.9 54.3 49.9 44.7 65%

Adobe Lightroom

Launch Adobe Lightroom 5.2 3.3 3.1 3.0 42%

Import 140 photos 361.1 174.9 143.3 135.2 62%

Batch process 140 photos 
with filter preset 84.3 28.2 15.4 13.1 84%

Export 140 photos 620.5 259.6 187.1 146.7 76%

Kinemaster

Time to export 1080p video 177.2 123.8 121.1 116.4 34%

Google Tour Creator

Open Google Tour 
Creator template 5.4 4.5 4.6 4.7 13%

Publish Google Tour 
Creator tour 6.8 6.4 5.5 6.9 -1%

Scenario 3

Median sum of all tasks for 
Scenario 3 48.5 33.5 27.2 24.4 49%

Google Slides

Open shared Google 
Slides presentation 13.3 7.7 6.8 6.4 51%

Print Preview Google 
Slides presentation 10.6 10.8 9.3 8.0 24%

Begin Google 
Slides Presentation 7.7 6.7 3.7 3.1 59%

Screencastify

Open Recording in Project 
Editor 16.91 8.30 7.4 6.9 59%
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System configuration information
Table 2: The table below presents detailed information on the systems we tested.

System Acer Chromebook CB-
315-3H

Acer Chromebook Spin 
CP713-2W-38P1

Acer Chromebook Spin 
CP713-2W-5874

Acer Chromebook Spin 
CP713-2W-79H3

Processor Intel Celeron N4020 Intel Core i3-10110U Intel Core i5-10210U Intel Core i7-10510U 

Processor frequency 
(GHz) 1.10 2.10 1.60 1.80

Processor cores 2 2 4 4

Memory (GB) 4 8 8 16

Storage (GB) 64 256 128 128

Bluetooth 5 5 5 5

USB 2x USB 3.1 Type-C 
2x USB 3.1 Gen 1

2x USB 3.1 Type-C 
1x USB 3.1 Gen 1

2x USB 3.1 Type-C 
1x USB 3.1 Gen 1

2x USB 3.1 Type-C 
1x USB 3.1 Gen 1

Battery type Lithium-Ion Lithium-Ion Lithium-Ion Lithium-Ion

Battery capacity (Wh) 48 48 48 48

Display 15.6” 1366x768 13.5” 2256x1504 13.5” 2256x1054 13.5” 2256x1054

OS (version) 86.0.4240.112 86.0.4240.112 86.0.4240.112 86.0.4240.112

System Weight (lbs.) 4.19 3.02 3.02 3.02
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How we tested
Creating the background workload
To simulate typical Chromebook use, we ran a combination of news, email, chat, music, document viewing, and social media websites in the 
background. For websites that required accounts, we created test profiles and logged in the users on each device.

1.	 From the shelf, open Chromebook settings.
2.	 Navigate to the On Startup section of the settings. 
3.	 Select Open a specific page or set of pages.
4.	 Insert the following URLs, and click OK:

• Forbes.com
• Markets.ft.com/data
• Arstechnica.com
• mail.google.com
• slack.com (logged into Slack chat, #general channel)
• drive.google.com 
• docs.google.com (viewing document)
• youtube.com/feed/music
• drive.google.com (viewing document)
• sheets.google.com (viewing spreadsheet) 
• twitter.com
• facebook.com

5.	 Restart the Chromebook. Before testing, navigate through each tab to ensure that both devices have fully loaded the same content.

Testing the applications
For each scenario, we downloaded, installed, and pinned the requisite apps to the Chrome shelf. For applications that required accounts 
or Google Authentication, we created test profiles and logged in the users on each device. We tested each task for a given scenario 
sequentially. After one run of a given scenario, we reset the Chromebook and performed two additional runs for a total of three. 

Scenario one

Google Meet
Launching Google Meet
1.	 Simultaneously start the timer and launch the Meet app from the shelf.
2.	 When the app fully loads and the webcam preview appears, stop the timer. 

Launching a new Google Meet meeting 
1.	 From the Meet main screen, simultaneously start the timer and click New meeting.
2.	 When the meeting invite code appears and the webcam preview refreshes, stop the timer. 
3.	 Join a four-way video call, and minimize the app for the remainder of the Scenario One tasks.

Google Drive
Open PDF preview from Google Drive
1.	 From the Google Meet chat window, simultaneously start the timer, and click the link to the test PDF.
2.	 Stop the timer when the PDF preview fully loads in the web browser. 

Print Preview PDF
1.	 From the Google Meet chat window, click the link to the test PDF shared via Google Drive. 
2.	 When the PDF loads, simultaneously start the timer, and click the Print icon.
3.	 Stop the timer when the print preview fully loads. 
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Google Docs
Open shared .docx file In Google Docs
1.	 From the Google Meet chat window, click the link to the test .docx file shared via Google Drive. 
2.	 When the .docx file preview loads, simultaneously start the timer, and click the Open with Google Docs button from the top menu.
3.	 Stop the timer when the Google Docs editor fully loads. 

Convert .docx file to Google Docs document 
1.	 From the Google Meet chat window, click the link to the test .docx file shared via Google Drive.
2.	 When the .docx file preview loads, click the Open with Google Docs button from the top menu.
3.	 From the Google Docs editor, click the File dropdown menu.
4.	 Simultaneously start the timer, and click Save as Google Docs.
5.	 Stop the timer when the newly opened Google Doc fully loads. 

Downloaded converted Google Doc to .docx
1.	 From the Google Meet chat window, click the link to the test .docx file shared via Google Drive.
2.	 When the .docx file preview loads, click the Open with Google Docs button from the top menu.
3.	 From the Google Docs editor, click the File dropdown menu, and select Save as Google Docs.
4.	 When the newly opened Google Doc fully loads, click the File dropdown menu, and hover over Download.
5.	 Simultaneously start the timer, and click Microsoft Word (.docx) from the Download menu.

6.	 Stop the timer when the download notification completes.

Scenario Two

Unarchiving Photos 
Transfer 140 photo .zip archive from USB 
1.	 Prepare a flash drive with the test .zip archive. 
2.	 Connect the flash drive to the system under test. 
3.	 Open the File application from the ChromeOS application launcher, and select the attached drive.
4.	 Click and drag the .zip archive to the Download folder. Start the timer before releasing the trackpad mouse button. 
5.	 Stop the timer when the file transfer completes. 

Unzip 140 photos from the Desktop 
1.	 From the Files application, navigate to the test archive location. 
2.	 Double-click to open the test archive using the default system viewer. 
3.	 Select the contents of the test archive, and click and drag the contents to an empty folder.
4.	 Simultaneously start the timer and unclick the dragged content.
5.	 Stop the timer when the copying files dialog completes.

Adobe Lightroom
Launch Adobe Lightroom
1.	 Simultaneously start the timer, and launch Adobe Lightroom from the shelf. 
2.	 Stop the timer when the app has fully loaded. 

Import 140 photos 
1.	 From the Adobe Lightroom home page, click the blue import photos icon.
2.	 Sort by Device Folders, and select the unarchived test photos by clicking the checkbox next to the folder name.
3.	 Simultaneously start the timer, and click Add.
4.	 Stop the timer when the import dialog completes. 

Batch process 140 photos with filter preset 
1.	 From the Adobe Lightroom home page, click the collection containing the test photos.
2.	 Click the first image.
3.	 Click the Adjustments icon.
4.	 Click Auto to apply auto adjustments. 
5.	 Click the menu button in the top right, and select Copy Settings.
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6.	 Leave the default Copy Settings, and click OK. 
7.	 Click the back arrow to return to the collection view.
8.	 Long click the first photo to select it. 
9.	 Click the menu button in the top right, and select Select All. 
10.	 Click the menu button in the top right again, and select Paste Settings.
11.	 Simultaneously start the timer, and click Apply.
12.	 Stop the timer when the processing dialog closes, and “Changes applied to 140 photos” appears. 

Export 140 photos
1.	 From the Adobe Lightroom home page, click the collection containing the test photos.
2.	 Click to select the first image. 
3.	 From the dropdown menu, click to Select All images. 
4.	 With all images selected, click the Share icon.
5.	 From the Share dialog box, click Export As…
6.	 Leave the default settings. Simultaneously start the timer, and click the checkmark icon.
7.	 Stop the timer when the export dialog completes. 

Kinemaster
Time to export 1080p video 
1.	 Launch the application from the shelf. 
2.	 Click the + icon to create a new video project.
3.	 Click 16:9 to set the video aspect ratio.
4.	 From the Media Browser, click to select the test video footage. Import the test audio, and test photo files.
5.	 From the video editor, click the export icon.
6.	 Leave the default Resolution and Frame Rate settings. Simultaneously start the timer, and click Export.
7.	 Stop the timer when the export completes.

Google Tour Creator
Open Google Tour Creator Template
1.	 Open the Chrome Browser window, and navigate to the Google Tour Creator web application (arvr.google.com).
2.	 Click Get Started.
3.	 Click to select the Templates tab.
4.	 Simultaneously start the timer, and click the New York City template. 

Publish Google Tour Creator tour
1.	 From the Google Tour Creator editor, click Publish.
2.	 Simultaneously start the timer, and click Publish again.
3.	 Stop the timer when the published tour preview fully loads.  

Scenario Three

Google Slides
Open shared Google Slides Presentation
1.	 From the Google Meet chat window, simultaneously start the timer, and click the link to the Google Slides test document shared via 

Google Drive.
2.	 Stop the timer when the Slides presentation fully loads. 

Print Preview Google Slides Presentation
1.	 From the Google Meet chat window, click the link to the Google Slides test document shared via Google Drive.
2.	 When the Slides presentation loads, click the File dropdown menu.
3.	 Simultaneously start the timer, and click Print.
4.	 Stop the timer when the Print Preview fully loads. 

Begin Google Slides Presentation
1.	 From the Google Meet chat window, click the link to the Google Slides test document shared via Google Drive.'
2.	 Simultaneously start the timer, and click the Present button.
3.	 Stop the timer when the Presentation fully loads. 
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Screencastify
Open Recording In Project Editor 
1.	 From the Chrome browser, click the Extensions icon.
2.	 From the Extensions menu, click Screencastify - Screen Video Recorder. 
3.	 When the Screencastify extension menu loads, click the Record button.
4.	 Click to select Entire Desktop.  
5.	 Record 5 minutes of the Google Slides presentation set to loop and auto advance every 10 seconds. When recording reaches 5 minutes, 

the Chrome Screencastify extension will open. 
6.	 Simultaneously start the timer, and click Project Editor.
7.	 Stop the timer when the video editor fully loads. 

Export presentation video to .mp4 
1.	 From the Editor window, click to expand the Download options.
2.	 Click Export as MP4.
3.	 Check Convert to fixed frame rate, and leave the default value of 30.
4.	 Simultaneously start the timer, and click Export.
5.	 Stop the timer when the export dialog completes. 
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:
Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc. specifically disclaims 
any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any implied warranty of fitness for any 
particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that Principled Technologies, Inc., its employees and its 
subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any alleged error or defect in any testing procedure or result. 

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if advised of the 
possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in connection with Principled 
Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.

This project was commissioned by Intel.

Principled
Technologies®

Facts matter.®Principled
Technologies®

Facts matter.®

Read the report at http://facts.pt/hxt6e7a

Intel contributes to the development of benchmarks by participating in, sponsoring, and/or contributing technical support to various 
benchmarking groups, including the BenchmarkXPRT Development Community administered by Principled Technologies.

Software and workloads used in performance tests may have been optimized for performance only on Intel microprocessors.  

Performance tests, such as SYSmark and MobileMark, are measured using specific computer systems, components, software, operations and 
functions.  Any change to any of those factors may cause the results to vary.  You should consult other information and performance tests to 
assist you in fully evaluating your contemplated purchases, including the performance of that product when combined with other products.   
For more complete information visit www.intel.com/benchmarks.

Intel’s compilers may or may not optimize to the same degree for non-Intel microprocessors for optimizations that are not unique to Intel 
microprocessors. These optimizations include SSE2, SSE3, and SSSE3 instruction sets and other optimizations. Intel does not guarantee 
the availability, functionality, or effectiveness of any optimization on microprocessors not manufactured by Intel. Microprocessor-dependent 
optimizations in this product are intended for use with Intel microprocessors. Certain optimizations not specific to Intel microarchitecture are 
reserved for Intel microprocessors. Please refer to the applicable product User and Reference Guides for more information regarding the 
specific instruction sets covered by this notice.

Performance results are based on testing as of dates shown in configurations and may not reflect all publicly available updates.  See backup 
for configuration details.  No product or component can be absolutely secure. 

Your costs and results may vary. 

Intel technologies may require enabled hardware, software or service activation.

© Intel Corporation.  Intel, the Intel logo, and other Intel marks are trademarks of Intel Corporation or its subsidiaries.  Other names and 
brands may be claimed as the property of others.
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